
 

 
This file was created by scanning the printed publication. 
Text errors identified by the software have been corrected; 

however, some errors may remain. 





Abstract

Reynolds, Keith M.; Holsten, Edward H. 1997. SBexpert users guide
(version 2.0): a knowledge-based decision-support system for spruce
beetle management. Gen. Tech. Rep. PNW-GTR-401. Portland, OR: U.S.
Department of Agriculture, Forest Service, Pacific Northwest Research
Station. 62 p.

SBexpert version 2.0 is a knowledge-based decision-support system for spruce
beetle (Dendroctonus rufipennis (Kby.)) management developed for use in
Microsoft (MS) Windows with the KnowledgePro Windows development language.
Version 2.0 is a significant enhancement of version 1.0. The SBexpert users guide
provides detailed instructions on the use of all SBexpert features. The SBexpert
application now consists of four separate programs: SBexpert (formerly, the Anal-
ysis topic in version 1.0), SBtext, SBlit, and SBhelp. SBexpert is an advisory
system for spruce beetle management that provides recommendations for re-
ducing spruce beetle hazard and risk to spruce stands and is the main application
of the full system. SBtext and SBlit provide complementary decision support.
SBtext provides background information on the biology, ecology, and manage-
ment of spruce beetles. SBlit provides database utilities for retrieving literature
citations. Basic features of the SBexpert system include an intuitive graphical user
interface, efficient presentation and retrieval of information through hypertext and
hypergraphics. easy access to an extensive help system for MS Windows system-
ievei help, window-specific help, a text editor that facilitates preparing standard
reports from SBtext. and automatic report generation in SBexpert.

Keywords: Spruce beetle, risk, Hazard, decision support, knowledge base, expert
system, management, software.

Authors

KEITH M. REYNOLDS is a research pathologist, Pacific Northwest Research
Station, Forestry Sciences Laboratory, 3200 SW Jefferson Way, Corvallis, OR
97331; and EDWARD H. HOLSTEN is a research entomologist, Alaska
Region, Forest Health Management, 3301 C Street, Suite 522, Anchorage,
AK 99508.



Contents

1 Introduction

2 New Features in Version 2.0

2 SBexpert Basics

2 Screen Objects and Manual Conventions

3 Mouse Control

3 Keyboard Control

4 Hypertext and Hypergraphics

4 Installation and Setup

4 Preparing for Installation

5 Installation

5 Setup Procedures for Microsoft Windows

6 Upgrading From SBexpert Version 1.0

7 Starting SBexpert

7 MS Windows Program Manager

7 MS Windows File Manager

9 Standard Elements of SBexpert Windows

9 The Menu Bar

11 The Control Menu

13 Getting Help in SBexpert

13 The Help Menu

13 Using the Help Window

15 Other Sources for Help

15 THE SBtext Program

16 Opening SBtext

16 The SBtext Button Bar

17 Navigating in SBtext



18 Copying Text and Graphics From SBtext to an SBexpert Editor

20 Copying Graphics

21 THE SBlit Program

22 Opening SBlit

22 Choosing Criteria to Define a Search

24 Copying SBlit Citations to an SBexpert Editor

26 THE SBexpert Program

26 The Scientific Basis for SBexpert

33 Opening and Closing SBexpert

33 SBexpert Utilities

34 SBexpert Editors

39 Recovering From Mistakes

39 The Hazard Topic

46 The Risk Topic

56 Switching Among Running Applications

59 Acknowledgments

59 Literature Citations

60 Appendix A: Hardware and Software Requirements

61 Appendix B: Keyboard Commands

62 Appendix C: Basic Editing



Introduction

SBexpert version 2.0 is a knowledge-based decision-support system for manage-
ment of spruce beetle (Dendroctonus rufipennis (Kby.)), developed cooperatively
by the Pacific Northwest Research Station and Forest Health Management, Alaska
Region of the USDA Forest Service. Version 2.0 was developed for Lutz (Picea
xlutzii), white (Picea glauca (Moench) Voss), and Sitka spruce (Picea sitchensis
(Bong.) Carr.) in south-central Alaska, but later versions easily could extend ap-
plicability of SBexpert to spruce beetle management for most of western North
America. The guide provides detailed instructions on the use of all SBexpert fea-
tures. In addition, it describes procedures for installing the system, and hardware
and software requirements (appendix A).

SBexpert is a Microsoft® Windows™ (MS Windows) application written in the
KnowledgePro® Windows development language.1 The SBexpert application
includes four programs: SBexpert, SBtext, SBlit, and SBhelp (throughout the
user guide, SBexpert program names as well as topics (subprograms) within
programs are identified in Arial bold). The sets of programs constitute the
SBexpert application. When we refer to the application as a whole, we use
"SBexpert."

• SBhelp is the SBexpert help system.

• SBexpert is an advisory system for spruce beetle management that pro-
vides recommendations for reducing spruce beetle hazard and risk to
spruce stands. SBexpert is the main analytical component of the system.
The section, "The SBexpert Program," consists of two main subsections
that describe the Hazard and Risk topics.

• SBtext and SBlit provide complementary decision support for SBexpert.
SBtext provides background information on the biology, ecology, and man-
agement of spruce beetles. SBlit provides database utilities for retrieving
SBlit citations. A separate utility program, SBIitnew (not distributed with
the system), is used by the authors to update the SBlit database.

' The use of trade or firm names in this publication is for reader
information and does not imply endorsement by the U.S. Depart-
ment of Agriculture of any product or service. Windows is a
registered trademark of Microsoft Corporation (One Microsoft Way,
Redmond, WA 98052; phone 206-637-7098). KnowledgePro is a
registered trademark of Knowledge Garden, Inc. (5116 Hartwick
Lane, West Palm Beach, FL 33415; phone 407-615-8209).
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Basic features of the SBexpert system include:

1. An intuitive, graphical user interface.

2. Efficient presentation and retrieval of information through hypertext and
hypergraphics.

3. Easy access to an extensive help system for MS Windows system-level help,
topic-specific help, and window-specific help.

4. A text editor that facilitates preparing standard reports from SBtext

5. Automatic report generation in SBexpert.

New Features in Version 2.0

• The original SBexpert application has been broken into four separate
programs and compiled in C++. It now runs much faster as a result.

• The hazard and risk analyses now cover Sitka spruce in addition to Lutz
and white spruce.

• The help system has been completely overhauled to look and feel like
standard Windows help systems.

• All text-based resources are now stored in archives, which makes the
information more secure and speeds retrieval.

• The installation process has been automated and greatly simplified.

• Choice of text editor is now configurable (MS Windows Write is the default).

• Figures from SB text can be copied to the Text Editor if the editor
supports graphic display.

SBexpert Basics

If you are already familiar with MS Windows, you know almost everything neces-
sary to run SBexpert. A quick review of this guide is recommended, however,
because a few aspects of program operation are unique to SBexpert. If you are
new to MS Windows, this guide provides detailed documentation on the use of
SBexpert, beginning with the basics covered in this section.

Screen Objects and Manual Conventions

SBexpert uses the graphical user interface of the MS Windows environment. In
MS Windows, software applications gather information from, and provide applica-
tion control to, the user with screen objects such as menus, buttons, radio
buttons, list boxes, etc., that are displayed in windows. Throughout this guide,
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screen objects are indicated in bold italic, as in the previous sentence. Techni-
cally, windows also are screen objects, but these are not highlighted to avoid
cluttering the guide with too many highlighted terms. Items displayed in menus,
list boxes, and radio buttons, for example, are choices that can be selected and
are indicated in italic.

Mouse Control

The buttons on a mouse can be programmed for either right- or left-handed use
(they come configured for right-hand use). All mouse operations in SBexpert use
the left button on a right-handed mouse or the right button on a left-handed
mouse. Almost all program control is accomplished by selecting screen objects
with the mouse. There are three basic mouse techniques:

• Single click: To select any screen object, position the mouse pointer on the
object, and click on the object. The term "select" in all instructions in this
guide always means "select the object with a single click."

• Double click: Position the mouse pointer on the choice and double click.
This method is frequently used in standard Windows applications to select
a choice from a list box. In SBexpert, however, almost all list box items
are now selected with a single click. In the few exceptional cases, we
provide a note prompting you to use a double click.

• Dragging: To mark a block of text for deleting, copying, or moving, click the
left mouse button at the beginning of the text block and, while holding the
button down, drag the mouse to the end of the block.

Keyboard Control

Control of SBexpert is easiest with a mouse, which therefore is recommended.
Control of screen objects, however, is explained in terms of both mouse and key-
board procedures. It is assumed that most users will use a mouse, so instructions
are given primarily in terms of mouse procedures. Keyboard procedures equiv-
alent to mouse procedures are indicated in parentheses in condensed form: for
example,

(Key: ALT+hyphen).

As illustrated in this example, keyboard commands often require a combination of
keys. Key-pressing combinations take one of three basic forms:

• The keyboard notation "key1+key2" means hold down key 1 and press
key 2.

• The keyboard notation "key1, key2" means press and release key 1,
then press key 2.
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• The keyboard notation "key1+key2, key3" means hold down key 1 and
press key 2, release keys 1 and 2, then press key 3.

Keys or key combinations shown in bold, as in

(Key: Ctrl+F6, Enter),

indicate that the bold portion of the key-press combination should be pressed
repeatedly until the desired screen object is highlighted.

All keyboard controls for navigating in MS Windows and operating on screen
objects in SBexpert are summarized in appendix B. Often, more than one alter-
native keyboard procedure is possible for a single mouse procedure. In the body
of this guide, when multiple keyboard alternatives exist, usually only the most
efficient method is shown. Keyboard methods for editing text are summarized in
appendix C.

Hypertext and Hypergraphics

All text displayed on the screen in green letters in SBexpert is hypertext.
Hypertext provides efficient access to cross references and deeper layers of
information. When a hypertext object in a window is selected, the material it
references is displayed in a window (generally, this is handled by SBhelp). In
SB text, for example, hypertext is used to provide definitions of terms, expanded
explanations of concepts, SBlit references, and graphic figures illustrating a par-
ticular topic. Hypertext appears throughout the SBexpert windows. First-time
users are encouraged to make liberal use of hypertext objects to become familiar
with the system and concepts used in its development.

Installation and Setup
Preparing for Installation

MS Windows must already be installed on your system before SBexpert is
installed, because the install program is an MS Windows application. If MS
Windows is not already installed, you MUST install it before proceeding further
with these instructions.

The installation program creates two subdirectories in addition to the \SBEXP2
directory. The \SBEXP2 directory contains the executable code for SBexpert and
associated text files. The \SBEXP2\STANDS directories contain high-resolution
bitmap images used in the hazard analysis component of SBexpert. The
\SBEXP2\EDITOR directory is empty when SBexpert is first set up. Reports gen-
erated by the application are automatically written to this directory by default.
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The standard version of SBexpert comes on 5 1.44-MB floppy disks. This version
includes a limited set of stand images for illustrating stand hazard. Optionally, a
complete set of stand images can be downloaded from the World Wide Web
homepage of the Protection of Forest Health and Productivity Research, Develop-
ment and Application (RD&A) Program (USDA Forest Service, Pacific Northwest
Research Station). The universal resource locator (URL) to get to the homepage
is "http://www.fsl.orst.edu/home/usfs/fhealth/fhealth.htm" .

Installation

Installation of SBexpert version 2.0 is now mostly automatic. You MUST install
from MS Windows, by using the File Run command. In Program Manager:

1. Select File on the menu bar.

2. Select Run from the File menu.

3. On the command line, enter A:!NSTALL

4. Select the OK button.

CAUTION: If you are upgrading to version 2.0 from version 1.0, be sure to read
the later section, "Upgrading From SBexpert Version 1.0."

By default, the source for installation is drive A:. If you are installing from drive B:,
type "B:INSTALL B:" at step 3 (Be sure to type the second B: in the command).

The default drive and directory for installation is C:\SBEXP2. The install program
displays this information in an edit line. Edit this line to specify either a different
drive or directory. From this point, installation is almost totally automatic. Just
follow directions on the screen. After the install program finishes creating direc-
tories and copying files, it continues with the necessary MS Windows setup.

Setup Procedures for Microsoft Windows

Microsoft Windows setup of SBexpert version 2.0 is now automatic. The install
program automatically:

1. Creates an SBexpert group in Windows Program Manager.

2. Adds program item icons to the group window.

3. Assigns icons to program items.

4. Creates a custom SBEXP2.INI file that the SBexpert system uses to locate
system directories and files.

When step 4 is completed, the install program informs you that installation is
complete and gives you the opportunity to view the README file.
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Upgrading From SBexpert Version 1.0

If you have SBexpert version 1.0 and are upgrading to version 2.0, three options
are possible:

1. Install version 2.0 into a different directory. The default directory for version 2.0
is "\SBEXP2," so the install program will not automatically overwrite an earlier
version. Although this is a simple alternative, it will use a great deal of hard
disk space.

2. Delete version 1.0 from your system completely and perform the full version
2.0 installation. This is safe and uses minimum disk space, but it takes extra
time.

3. Perform a partial install of version 2.0. Disks 3 to 5 of the installation set for
version 2.0 contain the identical set of stand image files contained in the
\SBEXP2\STANDS subdirectory.

Upgrade option 2—CAUTION: If you delete version 1.0, be sure that you copy
any report files out of the \SBEXP2\EDITOR subdirectory before deleting the
subdirectory.

Upgrade option 3—Option 3 for upgrading is the most efficient, and fairly easy to
do. We strongly recommend, however, that you not install version 2.0 over an
existing earlier version. Overwriting a previous version may be all right, but we
have not tested such a scenario. Moreover, there are many new files in version
2.0, and many old files in version 1.0 are no longer used.

To use this option:

1. Delete all files in the SBexpert version 1.0 directory.

2. Also delete the \SBEXP2\TEXTF!GS subdirectory and all its contents (they are
no longer needed).

Do steps 1 and 2 before beginning the version 2.0 installation. When the install
process starts, the installation program will detect the preexisting version 1.0
directories, and automatically bypass copying the stand images contained on
disks 3 to 5.

NOTE: The install program can detect the previous version only if you install to
the same directory name, if you installed version 1.0 to a directory other than
\SBEXPERT, specify the same name when installing version 2.0
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Starting SBexpert

MS Windows Program Manager

Start MS Windows by typing "win" at the DOS prompt. SBexpert can be started
from either the MS Windows Program Manager or the File Manager, but access
to programs is easier from Program Manager. Starting SBexpert from the MS Win-
dows File Manager is described in the next section. On most systems, Program
Manager is automatically displayed when MS Windows starts (fig.1). The SBexpert
application was installed in its own group window labeled "SBexpert 2.0."

To start SBexpert from the Program Manager:

1. If the SBexpert 2.0 group window is not already open, double click on the
SBexpert 2.0 program group icon to open the group window (Key: Ctrl+F6,
Enter) (fig. 2).

2. Double click on one of program item icons to start SBexpert, SBtext, or
SBlit (Key: arrow keys, Enter).

MS Windows File Manager

If MS Windows starts with the File Manager active instead of the Program Man-
ager, you may want to start SBexpert programs from File Manager. File Manager
displays directories on the system disk drives in various views. These instructions
cover the case in which the File Manager display uses the combined Tree and
Directory view (fig. 3). If the File Manager display does not look like figure 3, the
view can be changed by selecting the View menu (Key: ALT+V) from the File
Manager menu bar, and selecting Tree and Directories (Key: R) from the menu.

By default, the SBexpert application is installed in a directory named \SBEXP2 on
one of the system hard drives. Generally, SBexpert will be on the C or D drive, so
if the drive location of the SBexpert directory is not known, try these drives first.
To start SBexpert:

1. Change to the drive where the SBexpert directory is located, if necessary, by
selecting the appropriate drive icon (fig. 3) (Key: Tab, drive letter).

2. If necessary, scroll in the Tree window with the scroll bar until the SBexpert
directory is visible in the directory tree (Key: PgUp or PgDn).

3. Select the SBexpert directory in the Tree window to display the contents of the
directory in the directory window (Key: arrow).

4. Scroll in the directory window with the scroll bar (Key: PgUp or PgDn) until
the desired EXE file is located (if you are not using a mouse, first make the
directory window active by pressing the Tab key to switch between the Tree
and Directory windows).
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Figure 1—Microsoft Windows Program Manager with SBexpert program group
window closed.

Figure 2—The program group window for SBexpert in an open state.
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Figure 3—Using Microsoft Windows File Manager to start SBexpert.

5. Double click on the SBEXPERT.EXE, SBTEXT.EXE, or SBLIT.EXE in the
directory file listing to start SBexpert, SBtext, or SBlit, respectively (Key:
arrow, Enter).

Standard Elements of SBexpert Windows

Screen objects that appear in the main window of all three programs are the title
bar, minimize button, menu bar, and the control menu (fig. 4). The title bar
displays the name of the program. To temporarily exit one of the programs without
terminating it, select the minimize button to reduce the program to a program
item icon that is displayed at the bottom of the MS Windows desktop (fig. 5). You
can then easily access the MS Windows Program Manager or other MS Windows
applications that also may be running. For further information on navigating among
running MS Windows applications, see the section "Switching Among Running
Applications," below.

The Menu Bar

Many of the basic operations of SBexpert are controlled by selecting options from
the menus displayed on the menu bar. To select an option from a menu:

1. Select the menu to open it (Key: ALT+H, for example, to open the Help menu).

2. Select the option on the menu (Key: underlined letter in option).
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Figure 4—Main window of the SBexpert (analysis) program.

Figure 5—Example of a minimized program icon.
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To close a menu without selecting an option:

• Click the mouse anywhere outside the open menu (Key: ESC), or

• Select a different menu.

The Control Menu

To open the control menu of a main SBexpert window in normal view (fig. 6),
select the button (Key: ALT+spacebar). To open the control menu in minimized
view (fig. 7), select the SBexpert program Icon displayed at the bottom of the MS
Windows desktop (Key: ALT+ESC, Enter).

Menu items on the application control menu are Restore, Move, Size, Minimize,
Maximize, Qlose and Switch to (figs. 6 and 7). The Qlose, Move, and Maximize
options are always selectable, whether an SBexpert program is currently
displayed in normal view (fig. 4) or minimized view (fig. 5). When the control
menu is open:

• Select Restore (Key: R) to return an SBexpert program window to full size
(fig. 4) after it has been minimized (fig. 5). Restore is available only when
an SBexpert program has been minimized (that is, reduced to a program
item icon), in which case the program icon is displayed near the bottom
of the MS Windows desktop (fig. 7). To use Restore, first select the
program icon (Key: ALT+ESC, Enter) to open the control menu, then
select Restore (Key: R). In minimized view, double click on the minimized
program item icon to restore the program window without displaying the
control menu (Key: ALT+Tab).

• Select Move (Key: M) to relocate an SBexpert program window on the MS
Windows desktop. After selecting Move, the cursor changes to a four-
headed arrow. Use the arrow keys to reposition the window, and press the
Enter key when done. The title bar also can be dragged with a mouse to
position an SBexpert program window on the screen.

• Select Size (Key: S) to resize an SBexpert program window. After selecting
Size, the cursor changes to a four-headed arrow. Use the arrow keys to
resize the window, and press the Enter key when done. Window size is
more conveniently adjusted with a mouse. To resize with a mouse, move
the cursor over the edge of the window frame. The cursor changes to a
double-headed arrow. Click and drag the window frame to resize.
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Figure 6—SBexpert control menu.

Figure 7—Opening the control menu on a minimized program icon.
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• Select Minimize (Key: N) to reduce an SBexpert program to a program
item icon displayed at the bottom of the MS Windows desktop (fig. 5).
Minimize is available only when a main SBexpert window is displayed in
normal view (fig. 4) (that is, not minimized). Selecting Minimize from the
control menu is equivalent to selecting the minimize button with a
mouse and is the only keyboard method for minimizing an application.

• Select Maximize (Key: X) to expand an SBexpert program to fill the entire
desktop. Maximize is not available when a main SBexpert window is al-
ready maximized. Selecting Maximize from the control menu is equivalent
to selecting the maximize button with a mouse and is the only keyboard
method for minimizing an application.

• Select Qlose (Key: C) to terminate the program. In normal view, double
click on the control menu to close the program without opening the
control menu.

Getting Help in SBexpert

In addition to this guide, an extensive on-line help system is available in SBexpert.
The help system has been extensively revised in SBexpert version 2.0, and now
has the look and feel of a standard MS Windows help system. Each of the three
SBexpert programs (SBexpert, SBtext, and SBlit) have a Help menu (fig. 8).
The list of menu items is identical on all three menus.

The Help Menu

• The Help Menu contains the following menu items.

• Contents displays the main table of contents for the help system.

• Introduction provides complete step-by-step instructions on use of
SBexpert, SBtext, and SBlit.

• Definitions explains the meaning of key terms as they are used in the
SBexpert system.

• How to explains some standard MS Windows procedures for working with
screen objects.

• Using SBexpert Help explains use of the help system.

Using the Help Window

SBhelp is a separate SBexpert program that is started when a menu item is
selected from the Help menu in SBexpert, SBtext, or SBlit. The initial contents
of the help window are determined by the menu item that was selected from the
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Figure 8 - -The help menu is common to all SBexpert programs.

Help menu (see the previous section). Ail text displayed in green within the ap-
plication is hypertext, which leads to either a deeper level of explanation of a
topic or a related topic Simply select the hypertext (Key: Tab, Enter) to view it.

The Help Window aiso contains a button bar with buttons for various help
functions (fig. 9), Select one of the following buttons:

• Contents (Key: F1) displays the main table of contents for the help system.

• Search (Key: F2) displays a iist of all help topics. Select an item from the
list, then select the Go to button to display the selected topic, or select
the Cancel button to quit the search window (Key: type the name of the
topic, Tab to buttons. Enter).

• Back (Key: F3) goes back one topic in the chain of topics that have been
followed.

• Print (Key: F4) prints the contents of the current help display.

• Help (Key: F5) displays the Using SBexpert Help topic.

• Exit (Key: F6) exits the help system.
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Figure 9—The SBexpert Help program with button bar.

Other Sources for Help

Many display windows in SBexpert are annotated with instructions for using the
current window. Instructions often include hypertext that, when selected (Key:
Tab, Enter), activates the help system, which displays additional information
related to the hypertext topic.

The SBtext Program

The SBtext program is a hypermedia textbook that provides background informa-
tion on the biology, ecology, and management of spruce beetles. Subject matter is
displayed by selecting a chapter and section to view. Within chapter sections, ex-
panded discussions on selected topics, literature references, and graphic illustra-
tions are accessed by selecting hypertext. Deeper layers of information therefore
are readily available to users who want more details, but users experienced in a
particular subject can skip the additional detail. By organizing information into a
general text discussion and providing hypertext links, information retrieval is
optimized for most users.

SBtext can be used in combination with an external Text Editor such as MS
Windows Write, for example, to compose introduction and discussion sections for
basic reports. SBtext also can be used in combination with SBexpert's internal
Report Editor to add supplementary information on the biology, ecology, and
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Figure 10—The Utilities menu on the SBexpert menu bar.

management of spruce beetles to the report that is automatically created by
SBexpert. Copying text from SB text to either editor is a simple process because
all text displayed in a chapter-section window can be copied to a temporary MS
Windows file, called the clipboard, when a chapter section is displayed in SB text.

Opening SB text

In SBexpert version 2.0, SBtext (formerly, the Textbook topic in version 1.0) is a
stand-alone program. It can be started either from the Windows Program Manager
by double clicking on its program item icon in the SBexpert group window (fig. 2)
or by selecting Textbook from the Utilities menu of SBexpert (fig. 10, Key:
ALT+U, T).

The SBtext Button Bar

The SBtext window has a button bar that implements several functions (fig. 11):

• Contents (Key: F1) displays the list of chapters in SBtext as hypertext.

• Search (Key: F2) displays a list of all SBtext topics.

• Back (Key: F3) goes back one topic in the chain of topics that have been
followed.
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Figure 11—Main window of the SBtext program with button bar.

• Clipboard (Key: F4) copies the contents of the SBtext window to the MS
Windows clipboard.

• Print (Key: F5) prints the contents of the current help display.

• Edit (Key: F6) opens an external text editor.

• Help (Key: F7) displays the Using SBexpert Help topic.

• Exit (Key: F8) exits SBtext.

Each function is described in greater detail in subsequent sections.

Navigating in SBtext

The SBtext window initially displays a list of chapters as hypertext. This is the
main contents for SBtext. As elsewhere in SBexpert 2.0, hypertext items are
always highlighted in green text in the application. Select a chapter to view a list
of the sections covered by the chapter (Key: Tab, Enter). From the list of chapter
sections, select a section to view.

SBtext maintains a history of the topics that have been visited in the current
session.
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• To backtrack to a previous topic, select the Back button from the button
bar (Key: F3).

• To return to the SB text table of contents, select the Contents button from
the button bar (Key: F1).

• To randomly access hypertext topics, select the Search button (Key: F2).
Select an item from the list, then select the Go to button to go to the
selected topic, or select the Cancel button to quit the search window
(Key: type the name of the topic, Tab to buttons, Enter).

Copying Text and Graphics From SB text to an SBexpert Editor

Two editors are available in the SBexpert application. The Report Editor is an
integral part of the SBexpert program and is used by SBexpert to automatically
output results of analyses. While an analysis is in progress, the Report Editor
can be opened to add supplementary information. The Text Editor is an external
application that SBexpert has been configured to use. By default, when SBexpert
was installed, the Text Editor was set to MS Windows Write. See the later sec-
tion, 'The SBexpert Editors," for additional information on use of the editors and
changing the default Text Editor.

To copy the contents of a chapter section in SB text to either editor:

1. Display the desired chapter section in SBtext.

2. Select the Clipboard button from the SBtext button bar (fig. 11) to copy the
text to the MS Windows clipboard (Key: F4).

3. Select the Edit button from the SBtext button bat (fig. 11) to open the Text
Editor (Key: F6), or open the Report Editor in SBexpert by selecting Report
from the Editors menu (fig. 12, Key: ALT+E, R).

4. Position the cursor with the editing keys (appendix C), or by clicking the
mouse, so that the cursor is positioned in the editor window where the text is
to be inserted.

5. Select Paste from the editor's Edit menu (fig. 13).

When SBexpert is first started, the Report menu item on the Editors menu is
disabled (appears dim). The Report Editor cannot be opened until the Start
button on the introductory window has been selected and a name has been
assigned to the report for the current SBexpert session.
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Figure 12—The Editors menu on the SBexpert menu bar.

Figure 13—Opening the Edit menu in an SBexpert editor.
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Figure 14—View of a chapter section in SB text with a hyperlink to a graphic image
displayed.

Copying Graphics

In version 2.0, it is now possible to copy graphic images from SBtext to other
word processing documents that can display graphic images. The default Text
Editor, MS Windows Write, can display graphic images, but the Report Editor
cannot. To copy a bitmap image from a chapter section in SBtext to the Text
Editor,

1. Display the desired image in the chapter section in SBtext by selecting its
hypertext reference (fig. 14, Key: Tab, Enter).

2. Press the letter "C" to open MS Windows Paintbrush program and copy the
image to MS Windows Paintbrush.

3. Open the minimized Paintbrush program by double clicking on its program
item icon at the bottom of the desktop.

4. Select the rectangular selection tool from the Paintbrush (Key: save the
Paintbrush image to a file with ALT+F.S).

5. Drag the selection tool to select either the entire image or some portion of it
(no keyboard equivalent).

6. Select Qopy from the Paintbrush Edit menu (do not use for keyboard).
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7. Select the Edit button from the SB text button bar (fig. 11) to open the
Text Editor (Key: F6).

8. Position the cursor with the editing keys (appendix C), or by clicking the
mouse, so that the cursor is positioned in the editor window where the text is
to be inserted.

9. Select Easte from the editor's Edit menu (fig. 13, Key: select Insert Object
from the MS Write Edit menu (ALT+E, N), then choose Paintbrush picture
from the list of choices).

The SBlit Program

Literature searching is performed by the SBlit program. The present database of
spruce beetle literature contains over 450 references and is current through 1995.
Up to three authors and keywords as well as a range of years can be specified as
search criteria. After matching records have been retrieved from the database, the
selected references can be reviewed in a display window one record at a time.
When the display window is closed, the retrieved references are automatically
copied to the MS Windows clipboard, a temporary file managed by MS Windows.
The contents of the clipboard can be copied to either Text Editor or Report
Editor.

Opening SBlit

In SBexpert version 2.0, SBlit (formerly, the Literature topic in version 1.0) is a
stand-alone program. It can be started either from the MS Windows Program
Manager by double clicking on its program item icon in the SBexpert group
window (fig. 2) or by selecting Literature from the Utilities menu of SBexpert
(fig. 10, Key: ALT+U, L).

Choosing Criteria to Define a Search

The first SBlit window displays list boxes for selecting authors and keywords and
edit lines for entering the first and last years of a search (fig. 15). The combina-
tion of choices or entries made in these four fields specify the criteria for an SBlit
search. Any field can be left blank, in which case the blank field is treated as a
wildcard (that is, all SBlit records in the database match a blank field). In search-
ing the database, a record is retrieved only if it matches all selected search
criteria.

Up to three authors and keywords can be selected. The process for selecting
authors and keywords is identical. To select authors, for example (fig. 15):

1. Select the author list box to make it the active screen object (Key: Tab).
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Figure 15—The main window of the SBlit program.

2. Use the scroll bar on the right side of the list box to scroll through the list of
authors (Key: PgUp or PgDn or arrows).

3. Select an author (Key: Spacebar) to add the name to the list of selected
authors {reselecting an author that is already selected removes the author
from the list of selected authors).

4. Repeat steps 2 and 3 to select up to three authors (Key: Enter to conclude
selection).

As authors are selected, the names are added to the edit line labeled "Selected
authors" to assist in keeping track of selections (fig. 15). Author names also can
be typed directly into the selected authors edit line, with names separated by a
blank space.

To limit a search to a specific range of years (fig. 15):

1. Select the first year or last year edit line to make it the active screen object
(Key: Tab).

2. Type the year (for example, 1980).

When an edit line is the active screen object:

• Click with the mouse or use the Home, End, and left and right arrow keys
to position the edit cursor within the line.
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Figure 16—Selecting the logical relation between authors in a literature search.

• Use the Delete (Del) and Backspace (BkSp) keys for deleting text.

• Click and drag to select a block of text for editing or deletion (press the Del
key to delete selected text or begin typing to replace selected text).

After all search criteria have been specified, select the OK button to proceed
(fig. 15) (Key: Tab, Enter). If multiple authors or keywords were selected, a win-
dow opens, asking for the logical relation between the selections (fig. 16) (AND or
OR). AND means select a citation only if all author criteria are met. OR means
select a citation if any author criteria are met. Select the appropriate logical rela-
tion by double clicking the selection (Key: arrow, spacebar, Enter), and then
select the OK button (Key: Tab, Enter).

After a brief delay, the selected citations are displayed (fig. 17). Only one citation
is displayed in the citation window at a time. Select buttons at the top of the
citation window to:

• Move to the next citation (Key: F1).

• Move to the previous citation (Key: F2).

• Delete (drop) the current citation (from the retrieved list but not from the
permanent database) (Key: F3).

• Close the citation window (Key: F4).
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Figure 17—View citations obtained from an SBlit literature search.

When the Close button is selected (fig. 17), the citation window is cleared, and
a message about copying citations is displayed in the window along with an OK
button. After the OK button is selected (Key: Tab, Enter), two check boxes and
another OK button are displayed that provide options to include an abstract and
list of keywords with each citation (fig. 18). After selecting either or both citation
options (Key: Tab, Enter), select the OK button (Key: Tab, Enter) to copy the re-
trieved citations to the CLIPBOARD, which is a temporary MS Windows file. The
CLIPBOARD contents can then be pasted into either Text Editor or Report
Editor.

To terminate SBlit, select the CLOSE button located near the bottom of the main
SBlit window (fig. 15).

Copying SBlit Citations to an SBexpert Editor

SBlit citations can be copied to either SBexpert editor any time after the citations
window has been closed. It is not necessary to close SBlit. Because the list of
citations is stored in the MS Windows CLIPBOARD, the list should be copied into
the appropriate editor before further cutting or copying is performed and before a
new chapter section in SBtext is displayed. Cut and copy procedures as well as
the display procedure in SBtext also use the CLIPBOARD and always overwrite
the current contents of the CLIPBOARD. To copy the list of citations into one of
the editors (fig. 12):
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Figure 18—Selecting options for displaying citations after literature retrieval.

1. Select the Editors menu (Key: ALT+E) from the SBexpert menu bar.

2. Select either Text (Key: T) or Report (Key: R) from the menu.

If SBexpert has not already been opened in the current SBexpert session, the
Report option on the Editors menu will appear dim, thereby indicating that Report
Editor is not available. Assuming, however, that SBexpert had been opened

previously in the current session, Report Editor will open after the Report option
is selected.

To copy the contents of the MS Windows CLIPBOARD into either SBexpert editor
(fig. 13):

1. Position the cursor with the editing keys (appendix C) or by clicking the mouse
so that the cursor is positioned in the editor window where the text is to be
inserted.

2. Select the Edit menu from the menu bar of the editor (Key: ALT+E).

3. Select the Paste option from the Edit menu (Key: P).
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The SBexpert Program

The SBexpert program is an advisory system for spruce beetle management that
provides recommendations for reducing spruce beetle hazard and risk to spruce
stands and is the main analytical topic in SBexpert. SBexpert version 1.0 included
models only for spruce beetle hazard and risk appropriate to Lutz and white
spruce in south-central Alaska (Reynolds and Holsten 1994a). Hazard and risk
analyses in SBexpert 2.0 have been extended to also include Sitka spruce in
south-central Alaska (Reynolds and Holsten 1996). The modular structure of
SBexpert is such that new hazard and risk models can easily be added in later
versions to extend the geographic scope of the system. Individuals interested in
adding new hazard and risk models for new geographic areas or new spruce
species can contact the senior author (address given on the inside front cover).

The Scientific Basis for SBexpert

The concepts of hazard and risk—Our usage of the terms "hazard" and "risk"
follows Paine and others (1985). Hazard is the amount of stand damage expected
to occur as the result of a spruce beetle outbreak and typically is measured in
units of basal area, volume, or numbers of affected individuals. Hazard also can
be thought of as a measure of stand susceptibility to attack. In SBexpert, hazard
is expressed as a percentage of spruce basal area killed by spruce beetles 5 to
10 years after the start of an outbreak in a stand and is predicted in terms of var-
ious site and stand factors (Reynolds and Holsten 1994a). Because stand condi-
tions that affect hazard change relatively slowly, hazard predictions are useful for
developing strategic plans for forestwide treatment schedules.

Risk is a measure of the likelihood, or probability, that an outbreak will occur and
usually is expressed as a proportion (for example, a risk value of 1.0 indicates a
certain event). Although hazard and risk measure very different aspects of a
spruce beetle outbreak, the two measures also are closely related to each other
in our conceptual model. In particular, risk is predicted in terms of hazard as well
as the size of the available spruce beetle population. Spruce beetle populations,
in turn, are affected by availability of breeding materials and weather conditions
(Reynolds and Holsten 1994b), both of which may differ markedly from year to
year. Because the size of a spruce beetle population, and therefore the associated
risk, may change rapidly over a few years, reliable predictions of spruce beetle risk
can be made for only 2 to 3 years. Risk predictions, therefore, are most useful for
short-term tactical planning at the early stages of an outbreak.

The hazard model—Stand hazard is classified with a new classification model
(Clark and Pregibon 1991) developed for Lutz, white, and Sitka spruce on the
Kenai Peninsula, Alaska (Reynolds and Holsten 1996). Hazard, expressed as a
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Figure 19—Classification tree for predicted spruce beetle hazard classes. Nodes
labeled 1, 2, etc., correspond to nodes listed in table 1. Each terminal node is labeled
with its predicted hazard class (L=low, LM=low-medium, M=medium, MH=medium-high,
and H=high).

percentage of basal area loss due to spruce beetle-caused mortality at 5 to 10
years after start of an outbreak, is predicted from stand inventory data and physio-
graphic site data. The final decision-tree structure (fig. 19, table 1) distinguishes
13 possible hazard outcomes based on total stand basal area, percentage of total
basal area composed of spruce, percentage of spruce basal area composed of
trees with diameters >25 centimeters, stand elevation, and stand aspect. Four
paths in the decision tree lead to low-hazard outcomes (spruce basal area loss
<10 percent); two paths through the decision tree lead to a medium-hazard out-
come (spruce basal area loss >10 percent, but <40 percent); and three paths lead
to a high-hazard outcome (spruce basal area loss >40 percent). Four less precise
outcomes of low-medium and medium-high hazard were considered useful and
have been retained in the final model for south-central Alaska (fig. 19).

Results of model verification were considered very acceptable; in the worst case,
predictions of high hazard were correct for 73.7 percent of the observations.
Model validation results also were considered acceptable given the small number
of observations available for this phase of SBexpert. For a complete description
of hazard model development for south-central Alaska, see Reynolds and Holsten
(1996).
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Table 1—Decision tree for predicted spruce beetle hazard classes

Node

1
2

4

5

10

11

3
6
12
24

48

49

98
196

197

99

25
50

51

13
26
27

7
14

15

Descriptiona

Root
BA3 < 67.5
BA2 < 54.5
BA2 54.5
North < -0.15
North -0.15
BA3 67.5
Elev < 294.5
East < 0.96
BA1 < 20.4
East < -0.25
East -0.25
BA2 < 64
Elev < 251.5
Elev 251.5
BA2 64
BA1 20.4
East < 0.82
East 0.82
East 0.96
BA2 < 90
BA2 90
Elev 294.5
Elev < 442

Elev 442

N

286
30

14

16

7

9

256
204

183
90
49

41

17
6

11

24

93
82

1

21
15

6

52

45

7

Classb

L

L

L

M

L

H
L

H
H
L

H
L
L

H

H

M
M

M

L

L
H

H
H

M

P(L)C

0.77

.93

.63

.29

.89

.30

.35

.30

.38

.47

.27

.53
1.00

.27

.08

.22

.23

.18

.76
1.00

.17

.11

.09

.29

Probability

p(M)

0.17

.00

.31

.57

.11

.31

.31

.34

.22

.35

.07

.00

.00

.00

.12

.46

.40

.82

.10

.00

.33

.27

.20

.71

P(H)

0.06

.07

.06

.14

.00

.39

.34

.36

.40

.18

.66

.47

.00

.72

.79

.32

.37

.00

.14

.00

.50

.62

.71

.00

Leafd Hazarde

1

2

3

4

5

6

7

8

9

10
11

12

13

L

LM

L

LM

L

H

H

MH

M

L
MH

H

M

a Variable abbreviations are as follows: BA1, BA2, and BA3 are total stand basal area, spruce basal
area as a percentage of total, and basal area of large-diameter spruce as a percentage of spruce
basal area, respectively; east and north are indicator variables for angular departure (radians) of slope
aspect from east and north directions, respectively; and elev is stand elevation in meters.
b L, M, and H indicate nominal hazard classes of low, medium, and high, respectively, which
correspond to spruce mortality of 10 percent 10-40 percent, and >40 percent resprectively.
c p(L), p(M), and p(H) are probabilities that the corresponding node in the classification tree represents
low, medium, and high hazard, respectively.
d In fig. 19, the node designation appears in the first line of annotation immediately below each leaf.
6 Predicted hazard class assigned to the leaf. L, LM, M, MH, and H indicate low, low-medium,
medium, medium-high, and high hazard, respectively. Classes L, M, and H indicate predicted spruce
mortality of 10 percent 10-40 percent, and >40 percent, respectively. LM and MS indicate predicted
spruce mortality of 40 percent, and >10 percent, respectively.
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Hazard classes reported by SBexpert are low (0-10 percent), low-medium
( 40 percent), medium (11-40 percent), medium-high (>10 percent), and high
(>40 percent). Inventory data required for hazard classification are total stand
basal area (m • ha -1 ), percentage of stand basal area in spruce, and percentage
of spruce basal area in trees with a 25-centimeter diameter at breast height. Site
data required are elevation (meters) and slope aspect (degrees).

The risk model—Nine potential risk factors (table 2) were evaluated by spruce
beetle experts from western North America. Risk factors were organized into a
hierarchical model of spruce beetle risk (fig. 20) and the relative importance of
factors for determining risk was analyzed with the analytic hierarchy process that
derives subjective estimates of factor priorities through a process of pair-wise
comparisons (Saaty 1980).

Risk factors considered in the development of SBexpert were stand hazard, size
and trend of spruce beetle population in neighboring stands, daily ambient air
temperature maxima in the previous June, total rainfall in the past summer, and
availability of four types of breeding material (table 2). The beetle population trend
factor ultimately was dropped from SBexpert. Stand hazard and wind-thrown trees
were identified as the two most important factors determining risk of a spruce
beetle outbreak (table 3). Hazard and windthrow were considered about equally
important and together accounted for almost two-thirds of the total allocation of
priority among risk factors.

In SBexpert, a raw risk score, r, is initially computed as,

where

fi = priority of the ith risk factor, and

si = score for intensity of the ith factor.

Each risk factor is scored for intensity on a standard scale of 0 to 9, with si = 0
indicating absence of the ith factor and si = 9 indicating that the risk factor is
present and conditions associated with the factor are maximally conducive to
outbreak. Because the fi sum to 1.0, and all si are scaled on the interval [0, 9],
r also takes on values on the interval [0, 9].
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Table 2—Definitions of spruce beetle risk components

Component in hierarchya

Hazard (1)

Expected population (1):

Current population (2)

Population trend (2)

Weather (2):

Temperature (3)

Rainfall (3)

Breeding material (2):

Windthrow (3)

Right-of-way (3)

Fire (3)

Logging (3)

Factor
numberb

1

2

3

4

5

6

7

8

9

Definition of component

Expected spruce beetle damage to a
stand 5-10 years after start of an outbreak

Size of spruce beetle population in the
next 2 years in stands within 0.5 kilometer
of the target stand border

Spruce beetle-caused mortality in the
previous year (stems per hectare) in
stands within a 0.5-kilometer radius
of the subject stand

Relative change in tree mortality in stands
within a 0.5-kilometer radius of the subject
stand between 5 years ago and 1 year ago

Weather conditions local to the subject
stand and stands within 0.5 kilometer of
the subject stand

Cumulative degree-days in the
previous June

Total precipitation for June, July,
and August in the previous 12 months

Breeding materials in either the
subject stand or stands within 0.5 km
of the subject stand that were
available for spruce beetle brood
production in past 2 years

Maximum density of windthrown
trees (stems per hectare)

Maximum density of trees felled for
right-of-way clearing (stems per hectare)

Area damaged by fire (in hectares)

Area that was logged (in hectares)

a Numbers in parentheses indicate the level of a component in the hierarchical structure of risk model
components (fig. 20).
0 Factors are model components that occupy terminal nodes in the model structure (fig. 20).
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Figure 20—Structure of the spruce beetle risk model. Square boxes indicate factors that
occupy terminal nodes in the model structure (table 2). Rounded boxes indicate
intermediate factors included to create a hierarchical structure.
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Table 3—Priorities of factors
spruce beetle outbreaka

Risk factorb

Hazard

Beetle population

Temperature

Rainfall

Breeding materialsd:

Windthrow

Right-of-way

Fire

Logging

Consistency ratioe

contributing to risk of a

Priorityc

0.32

.18

.09

.02

.33

.03

.03

.01

.01

a Priorities obtained as eigenvector solutions from analytic hierarchy
SBexpert.
b Arrangement of risk factors in analytic hierarchy model is illustrated
in figure 20, in which risk factors are shown as rectangles.
c Proportional contribution that a risk factor makes to the overall raw
risk score.
d See table 2 for definitions of materials.
e A consistency ratio 0.10 is considered acceptable. The value 0.01
indicates a high level of internal consistency in judgments used to
develop risk factor priorities.

The raw risk score is thus a simple linear function of risk factor intensities
weighted by their respective priorities. To approximately reproduce some of the
asymptotic behavior of risk lunctions commonly observed in nature, a final risk
score, r', is obtained as a Weibull transformation of r.

r'=1 - e(-r/5)3

For a more complete discussion on development of the spruce beetle risk model,
see Reynolds and Holsten (1994b).
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Figure 21—The main window of the SBexpert topic.

Opening and Closing SBexpert

In SBexpert version 2.0, the SBexpert program (formerly, the Analysis topic in
version 1.0) is a stand-alone program that is started from MS Windows Program
Manager by double clicking on its program item icon in the SBexpert group win-
dow (fig. 2). SBexpert initially displays a welcoming screen (fig. 21). Select the
Start button to begin an analysis of spruce beetle hazard and risk (Key: Tab,
Enter).

To exit SBexpert, select Exit from the File menu (Key: ALT+F, X), or double click
on the program window's control menu (fig. 21).

When SBexpert is first started, the Hazard and Risk menus appear dim (gray
instead of black). Whenever a menu or option in a menu appears dimmed, the
menu or option is currently inactive and cannot be selected. The Hazard and
Risk menus both change to black after an initial hazard analysis has been
completed in SBexpert, thereby indicating that these menus are now available.

SBexpert Utilities

SBtext and SBlit are utility programs that have been designed to provide comple-
mentary decision support for the SBexpert program. Detailed descriptions of the
use of these utilities is presented in earlier chapters. Both SBtext and SBlit can

33



Figure 22—The Utilities menu on the SBexpert menu bar.

be started either from the SBexpert group window by double clicking on the appro-
priate program item icon (fig. 2) or by selecting Textbook or Literature, respec-
tively, from the Utilities menu on the SBexpert menu bar (fig. 22). See the later
section, "Switching Among Running Applications," for suggestions on how to man-
age multiple programs on the MS Windows desktop.

SBexpert Editors

SBexpert has two text editors referred to as the Text Editor and the Report
Editor. The Text Editor is intended for use with SBtext and SBlit to assemble
text on selected topics and literature references into documents. The Report
Editor is specifically used to create and edit the report generated by an
SBexpert analysis. Both editors can be selected from the Editors menu of the
SBexpert menu bar (fig. 23, Key: ALT+E, then T or R).

Text Editor—Select Iext from the Editors menu to open a general Text Editor
(fig. 23, Key: ALT+E, T). By default, the SBexpert application is configured at
installation to use MS Windows Write as its general text editor. The SBEXP2.INI
file in the Windows directory can be edited to replace Write with any other editor
that may be preferred. The editor specified in the SBEXP2.INI file is used in both
SBexpert and SBtext. The primary use of the general editor is for assembling
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Figure 23—The Editors menu on the SBexpert menu bar.

background information on spruce beetle biology, ecology, and management for
reports. Graphic images from SB text also can be copied into Write. For general
instructions on editing procedures with Write, see the program's help menu.

SBexpert Reports—SBexpert automatically creates a report file for an analysis
after selection of the Start button. Much of the information displayed in windows
during the course of an analysis is also written to the report file to document the
analysis for later reference.

After selecting the Start button, SBexpert displays a window asking for the name
to be assigned to the hazard and risk report file (fig. 24). By default, the report is
written to the \EDITOR subdirectory of the main \SBEXP2 programs directory. The
default file name is sbmmddyy.rpt, in which mm, dd, and yy specify the month,
day, and year, respectively. To accept the default directory and file name, select
the OK button (Key: Tab, Enter) (fig. 24). In addition, the drive, directory, and file
name can all be changed.

• To change the drive for the report file, select the down arrow on the
drop-down list box labeled Drives to open the list box (Key: ALT+V), and
double click to select one of the available drives (Key: arrow, spacebar,
Enter).
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Figure 24—Specifying a file name for the SBexpert report.

• To change the directory, double click on the appropriate directory in the
Directories list box (Key: ALT+D, arrow, spacebar, Enter). If the directory
contains subdirectories, the contents of the list box will change to display
them. Continue selecting subdirectories until arriving at the one you wish to
use.

• To change the file name, select the File Name edit line (Key: ALT+N), and
use the arrow, Del, and BkSp keys to edit the name. Drive and directory

changes also can be typed directly in the File Name edit line.

After all changes have been made, select the OK button (Key: Tab, Enter) to
complete the file name selection. The main window of SBexpert changes to dis-
play introductory information about conduct of the present hazard analysis as soon
as the file name dialog window has closed. Select the OK button at the bottom
of the window to continue. Next, an edit window is displayed for recording notes
on the current stand (fig. 25). Use the edit window make any annotations that
may be relevant to the hazard and risk report. For example, at a minimum, the
location of the forest stand should be noted so that the location is mentioned at
the head of the report. Add as much commentary as you wish, however. Any doc-
umentation of personal observations may assist you or others in interpreting
SBexpert output. All basic editing functions are available in the edit window
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Figure 25—Edit window for annotating an SBexpert report to provide notes on the
current stand.

(appendix C). A scroll bar is located on the right side of the edit window in case
you get carried away! After entering the stand information, select the OK button
to close the edit window (Key: ALT+spacebar, C) and proceed to the hazard
analysis.

Opening the Report Editor—The Report Editor cannot be opened until the
report file has been created as described in the previous section. If the Editors
menu is selected before the report file is created (fig. 23), the Report menu item
will appear dim, indicating that the Report Editor is not yet available.

Basic editing in the Report Editor—Basic cut-and-paste editing can be
performed in the SBexpert Report Editor. To delete, copy, or move text in the
editor with either a mouse or keyboard commands, the text first must be selected.
To select a block of text:

1. Scroll to the start of the text block into view, if necessary, with the scroll bar
(Key: arrows, PgUp, PgDn keys).

2. Click the mouse to move the edit cursor to the start of the text block (Key:
arrows).

3. Drag the mouse over the text block to select it (Key: Shift+arrow).
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Once the text block has been selected:

• Press the Del key to delete the text.

• Select Copy from the Edit menu on the menu bar to copy the text.

• Select Cut from the Edit menu to move the text.

To complete a copy or move operation:

1. Position the edit cursor at the location where the text is to be inserted (Key:
arrows).

2. Select Easte from the Edit menu (Key: Alt+E, P).

Use the control menu of the Report Editor window to close the editor (Key:
Alt+hyphen, C).

Saving and renaming the report file—During an SBexpert analysis, any time
after a report file has been created, it can be saved under a new name by se-
lecting Save /\s from the Report Editor File menu (Key: ALT+F, A) and entering
a new name in the File Save As dialog window. Analysis output will now be writ-
ten to the new file, and the next time that the Report Editor is opened from the
Editors menu, the new report file will be opened.

Copying text and graphics among SB text, SBlit and the editors—The earlier
sections on SBtext and SBlit describe copying text, graphics, and literature
citations to the Text Editor. The same procedures can be used to copy text and
graphics from SBtext and literature citations from SBlit to the Report Editor
instead or in addition. Consequently, it is possible to assemble reports that
include:

1 Report information generated by an SBexpert analysis.

2. Supporting background information from a topic in SBtext.

3. Graphic images from SBtext.

4. Literature citations from SBlit.

Printed reports can include color illustrations, assuming that a color laser or ink-
jet printer is available. Graphic images also generally will print well to any high-
resolution printer that supports gray-scale printing (for example, a Hewlett-Packard
Laserjet IV), but image rendition will be very poor on more basic black-and-white
printers.
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Figure 26—A decision node in the classification model for hazard.

Recovering From Mistakes

The SBexpert program is composed of two main subtopics, Hazard and Risk,
each of which is composed of a lower level of subtopics that correspond to options
on the Hazard and Risk menus, respectively. Each subtopic of Hazard and Risk
has its own window that generally produces a series of displays in which re-
sponses of various sorts need to be entered. The current version of SBexpert
does not provide the ability to backtrack through a sequence of displays produced
within a single window. Consequently, if a mistake is made while entering hazard
data, for example, and the error is not caught until after an OK button has been
selected to proceed to the next display in the sequence, then the only option is to
finish progressing through the sequence until a CLOSE button is displayed within
the window or the window closes automatically after selecting the last OK button.
Each display in all display sequences includes an OK button to minimize the
chances of making an unintentional selection: no selections made in a display take
effect until the OK button in the display has been selected.

The Hazard Topic

The decision tree—The initial phase of a hazard analysis in SBexpert begins by
navigating through a decision tree (fig. 19). At each node, two mutually exclusive
choices and a third "not sure" alternative are available (fig. 26).
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Figure 27—Message about predicted hazard outcomes.

1. Select one of the three radio buttons (Key: arrow).

2. Select the OK button (Key: Tab, Enter).

The number of nodes that the decision path traverses through the decision tree
differs, depending on the particular path traversed and how often the "not sure"
alternative is selected. When the final node has been processed, the display
changes to a message with an OK button (fig. 27). Select the OK button to
proceed to the display of hazard outcomes.

Hazard outcomes—After the OK button is selected, the window is cleared,
and the results of the hazard SBexpert are displayed in abbreviated form in a list
box (fig. 28). Each entry in the list box lists a hazard outcome labeled "leafXX",
followed by the hazard rating for that leaf. Each leafXX defines a unique outcome
(position) on the decision tree (see the section, "Logic diagram," below).

Along with the set of hazard outcomes displayed in the list box, there is also an
EXIT button. Select this button to close the hazard SBexpert window and return
to the introductory SBexpert window.

NOTE: DO NOT select the EXIT button in this window (fig. 28) unless
you are COMPLETELY finished. Once the hazard analysis window is
closed, the HaZard and Risk menus are disabled, and it will not be
possible to examine the hazard and risk advice.
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Figure 28—Display of hazard outcomes.

The number of predicted hazard outcomes displayed in the list box depends on
how many times the "not sure" choice is selected while traversing the decision
tree. Only one hazard outcome is displayed if "not sure" is never selected. Each
time that "not sure" is selected, however, another possible hazard outcome is gen-
erated. The logic behind allowing the generation of multiple-hazard outcomes is
that there are multiple paths through the decision tree that lead to the same haz-
ard rating. Thus, it is possible to answer "not sure" at least once while responding
to questions in the decision tree and yet come up with a single level of predicted
hazard in the set of predictions. The "not sure" choice assures that the hazard
analysis can always run to completion: you are not necessarily stuck if you do not
have the information required to respond to all possible questions. On the other
hand, the set of predicted hazard outcomes may include more than one level of
hazard, in which case the missing information must be obtained to resolve the
predicted hazard outcome more precisely.

Some hazard outcomes are labeled "low-medium hazard" and some are labeled
"medium-high hazard." These designations are NOT what is meant by multiple
outcomes. "Multiple outcomes" means that at least two entries are listed in the
list box. In contrast, the low-medium and medium-high hazard outcomes might
be described as "fuzzy" outcomes; that is, the hazard model was not able to
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Figure 29—The Hazard menu on the SBexpert menu bar.

adequately distinguish among cases of, for example, low and medium hazard
based on the best available predictor variables, so the case was classified as the
fuzzier (less precise) outcome of low-medium.

IMPORTANT: A fuzzy hazard outcome of low-medium means that the
true hazard outcome is expected to be EITHER low OR medium. This
is quite different than interpreting low-medium as a hazard value inter-
mediate between low and medium.

From the set of hazard outcomes displayed (fig. 28):

1. Select a leaf, representing a specific hazard outcome, from the list box (Key:
arrow).

2. Select either Hazard Advice or View from the HaZard menu (fig. 29).

The Hazard Advice topic—Select HaZard Advice to get recommendations for
stand management to reduce hazard of a spruce beetle outbreak for the specific
hazard outcome selected from the list box. The Hazard Advice window (fig. 30)
presents details of the SBexpert hazard analysis for a selected outcome:

• It summarizes the stand attributes for the hazard outcome selected in
fig. 29.

• Explains the rationale for the hazard outcome.
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Figure 30—Viewing advice on reducing hazard.

• Reports the approximate reliability of predictions.

• Suggests specific stand treatments to reduce hazard.

While viewing the hazard advice window:

• Use the scroll bar on the right side of the hazard advice window to scroll
the full text.

• Select the logic diagram (Key: Tab) to view the logical path traversed in
the analysis and that leads to the particular hazard outcome selected in
(fig. 30).

• Select Close from the control menu (Key: ALT+hyphen, C) in the upper
left corner of the hazard advice window (fig. 30) to return to the list of
hazard outcomes in fig. 28.

The small logic diagram in the upper right corner of the hazard advice window
(fig. 30) is a miniature of the decision tree for the hazard model, and is a hyper-
link to a larger graphic of the decision tree (fig. 31). Select the logic diagram in
the hazard advice window to trace the logic of the decision process (Key: Tab).

Logic diagram—This window (fig. 31) illustrates the logical path used to arrive at
a hazard outcome.
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Figure 3 1 — Logic diagram for structure of the hazard classification model.

• Select the text labeled "HAZARD TREE" in the diagram for an explanation
of how to use the diagram (Key: Tab).

• Select the text labeled "CLOSE" in the diagram to close the logic window
and return to the hazard advice window (Key: Tab).

• Select any of the labeled decision nodes to get information about the node
(Key: Tab).

Stand visualization in the View topic—SBexpert displays highly realistic,
simulated images of forest stands damaged by spruce beetles. The stand images
are provided to help users better understand what a particular level of mortality
will look like. As with the hazard outcomes, to which the stand images correspond,
depicted damage represents approximate mortality 5 to 10 years after the start of
an outbreak. To initiate stand damage visualization:

1. Close the Hazard Advice window (fig. 30) if it is open, to redisplay the list of
hazard outcomes.

2. Select View from the HaZard menu (fig. 29)(Key: ALT+Z, V).

The View window completely covers the SBexpert application window, and a
dialog window is displayed, requesting more specific information on the spruce
composition of the stand, expressed as spruce basal area as a percentage of
total stand basal area (fig. 32).

44



Figure 32—Providing additional stand information for the View topic.

1. Select the appropriate spruce basal area percentage from the list box (Key:
Tab, arrow).

2. Select the OK button (Key: Tab, Enter).

Once a selection is made, the dialog window clears and displays a new ques-
tion on the percentage of spruce basal area in trees with a diameter >25.4 centi-
meters (10 inches). After again selecting the appropriate answer, a new window,
labeled "NOTES", displays information about how to use and interpret the stand
images (fig. 33). In the view window:

• Select the NOTES button to return to the NOTES window.

• Select the PRIOR button to view a stand, structurally similar to the one
you have described, before a spruce beetle outbreak.

• Select either the LOW, MEDIUM, or HIGH button (there will either be one
or two of these displayed) to view the associated hazard condition.

• Select the CLOSE button to return to the list of predicted hazard
outcomes (fig. 28).

If either a low-medium or medium-high hazard outcome was selected for viewing
from the list of hazard outcomes, then there will be two hazard condition buttons.
Otherwise, there will be only a single button for hazard condition.
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Figure 33—First window in View.

The Risk Topic

The Bisk menu remains dimmed, thereby indicating it is not selectable, until the
hazard analysis has been completed. Once the hazard analysis has been com-
pleted, a risk analysis can be requested to estimate the likelihood of an outbreak
for each hazard outcome. The Risk topic has three subtopics:

• New Risk: An initial risk analysis, based on assumed weather conditions
that occur commonly in the geographic region.

• Weather: An optional revised risk analysis, based on corrections to the
default weather conditions that are supplied by the user.

• Risk Advice: In which risk factors can be eliminated singly or in sets of
two or more to evaluate their influence on risk.

The optional risk analysis for weather effects and the risk advice topics cannot be
executed until the initial risk analysis has been completed.

The New Risk topic—To open the New Risk window and perform an initial risk
analysis, select New risk from the Bisk menu (fig. 34, Key: ALT+R, N). Other
options on the Risk menu are dimmed (not selectable) until New Risk has been
selected and its associated topics completed.
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Figure 34—The Risk menu on the SBexpert menu bar.

Once New risk is selected, the window for the New Risk analysis topic opens and
displays a set of radio buttons from which to select the range of spruce mortality
observed in neighboring stands (fig. 35).

IMPORTANT: Risk was defined earlier as the probability of an outbreak
occurring in the subject stand (as opposed to a neighboring stand). If
there is already at least one spruce beetle-attacked tree per acre (2.5
trees per hectare) within the subject stand, no need exists to perform
a risk analysis: you should consider that an outbreak may have already
started.

There is also an OK button located near the bottom of the window (fig. 35). To
proceed:

1. Select the appropriate radio button (Key: arrow) for the amount of beetle-
caused spruce mortality.

2. Select the OK button (Key: Tab, Enter).

After the OK button is selected, the display changes to request additional infor-
mation on the presence and amount of breeding materials such as recently
blown-down or fire-damaged trees. The display format for blown-down material
(fig. 36) is typical of all four displays on breeding material. In each display:

1. Select the appropriate radio button (Key: arrow).
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Figure 35—bntering data on tree mortality in the New risk topic.

Figure 36—Example of entering data on breeding materials in New risk.
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Figure 37—A message about risk predictions with default weather conditions.

2. Select any of the check boxes if they describe conditions in the subject, or
neighboring, stands (Key: Tab, Enter).

3. Select the OK button (Key: Tab, Enter).

IMPORTANT: pay attention to the wording of text in the displays re-
questing input on breeding materials. As already noted, the risk model
makes a distinction between conditions in subject and neighboring stands
with respect to the presence of spruce beetle-caused tree mortality.
Distinctions between effects in neighboring and subject stands occur
throughout the four displays for breeding materials. For example, in the
case of blown-down material (fig. 36), you are asked to indicate the
amount of blowdown in either the subject or neighboring stands by
selecting the appropriate radio button. There is also a check box for
indicating that blowdown occurred in the subject stand. Blowdown also
may have occurred in neighboring stands, but availability of more local
blowdown is considered an overriding influence in the SBexpert risk
model, so selecting the check box tor occurrence of blowdown in the
subject stand increases the factor score assigned to blown-down material.

After selecting the OK button in the fourth display of breeding materials (logging
material), the New Risk topic displays a message about default weather condi-
tions that are assumed for the initial phase of the SBexpert risk analysis (fig. 37).
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Figure 38—Risk predictions associated with each hazard class.

Read the descriptions of temperature conditions for the past June and of cumula-
tive rainfall for the past summer carefully. If temperature and rainfall are known to
deviate substantially from those described, then the initial risk analysis should be
followed by entering new weather data (see the section "The Weather topic,"
below). Select the OK button, (Key: Enter [the OK button is already selected, so
Tab is not needed]) near the bottom of the display, to proceed to the last display
in the New Risk topic.

The final display in an initial risk analysis shows the predicted risk of a spruce
beetle outbreak in the subject stand that is associated with each hazard class
(fig. 38). Select the OK button (Key: Enter) to return to the display of hazard out-
comes (fig. 39). The original display of hazard outcomes (fig. 28) is updated by
appending the predicted risk values to the hazard outcomes displayed in the list
box (fig. 39) and a message is displayed at the bottom of the window, indicating
that risk predictions are currently based on default weather conditions.

IMPORTANT: Fuzzy hazard predictions (for example, low-medium haz-
ard) have correspondingly fuzzy risk predictions (for example, 0.11-0.22).
Fuzzy risk predictions should be interpreted as either 0.11 or 0.22, for
example, depending on whether the true hazard outcome will be low or
medium hazard, respectively.
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Figure 39—Modified list of hazard outcomes with risk estimates appended.

The Weather topic—The initial risk analysis performed in New Risk is based on
default weather conditions considered to commonly occur in the geographic
region. If weather conditions are known to have deviated substantially from the
default conditions, then new weather data should be entered. To modify the
default weather conditions (fig. 37), select Weather from the Risk menu (Key:
ALT+R, W). The window for the Weather topic opens to display choices for daily
maximum air temperature conditions in the previous June in a set of radio
buttons (fig. 40).

1. Select the appropriate radio button for June temperature conditions (Key:
arrow).

2. Select the OK button to proceed (Key: Tab, Enter).

After the OK button is selected, the Weather window changes to a display
requesting input of total cumulative rainfall in a normal (average) year and in the
past summer (fig. 41). Enter the rainfall data in the two edit lines provided. An
edit cursor is already positioned in the first edit line for normal rainfall amount.

1. Type an answer to complete the first field.

2. Select the second field (Key: Tab).

3. Complete the second field.
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Figure 40—Overriding default air temperature assumptions in the risk model.

Figure 41—Overriding default rainfall assumptions in the risk model.
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Figure 42—Modified risk predictions associated with each hazard class after overriding
default weather conditions.

4. Select the OK button (Key: Tab, Enter) to proceed.

While the edit cursor is positioned in either edit line, use the Del, BkSp, and
arrow keys to edit the value entered if you make a mistake. After the OK button
is selected, the Weather topic window displays a new set of risk predictions for
each hazard class (fig. 42).

• Select the UPDATE button (Key: Enter) to modify the previous set of risk
predictions, or

• Select the CANCEL button (Key: Tab, Enter) if you do not wish to replace
the previous risk predictions.

After selecting either the UPDATE or CANCEL button, the window of hazard
outcomes is redisplayed (fig. 39). If risk predictions were updated, the message
displayed at the bottom of the window changes to indicate that default weather
conditions are no longer in effect.

The Risk Advice topic—To open Risk Advice, select Risk Advice from the Risk
menu (fig. 34, Key: ALT+R, R).
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Figure 43—Evaluating the influence of altering risk factors.

Figure 44—Example of modifying a risk factor.
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Figure 45—Example of a risk evaluation with modified risk factors.

The Risk Advice window displays a set of check boxes, each labeled with one
of the risk factors that have contributed to the current estimate of risk, as deter-
mined previously in the New Risk topic (fig. 43).

1. Select the check box (Key: Tab, Enter) corresponding to each risk factor to be
modified.

2. A new window opens. If the risk factor was not designated as local to the sub-
ject stand, a brief message is displayed, thereby indicating that the effect of the
factor will be removed. If the factor did occur in the subject stand, treatment
options are displayed in a set of radio buttons (fig. 44). Select the appropriate
radio button (Key: arrow, Enter).

3. Select the OK button (Key: Tab, Enter).

Repeat steps 1 through 3 for all risk factors that you wish to modify. After all
desired changes have been made,

4. Select the EVALUATE button (fig. 43).

A brief report of effects of the proposed changes in risk factors is then displayed
(fig. 45). Risk factors displayed in lower-case letters were eliminated only from
the subject stand. Risk factors displayed in upper-case letters were eliminated
from both the subject and neighboring stands. The effect on the risk outcome
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Figure 46—Example of a minimized program icon.

of modifying a risk factor depends on whether the factor was specified as local to
the subject stand or occurred only in neighboring stands. In general, a risk factor
present in the subject stand has a greater effect on increasing risk than a factor
that occurs only in neighboring stands. Most importantly, the model assumes that
if a risk factor occurs in the subject stand, it also occurs in neighboring stands.
There is no option to reduce a risk factor in neighboring stands when a local effect
is present, because (in the risk model) a local effect takes precedence. That is,
eliminating a risk factor from neighboring stands would have no influence on re-
ducing risk if the factor also is present within the subject stand.

Select the CLOSE button (fig. 45) to return to the list of risk factors. You can
select different combinations of risk factors to alter by repeating steps 1-4, above,
as many times as desired. In the window displaying the list of risk factors (fig. 43),
select the CLOSE button to close the Risk Advice window and return to the
listing of the hazard outcomes.

Switching Among Running Applications

SBexpert, SBtext, and SBlit as well as SBhelp are now independent programs.
Any or all SBexpert programs can be running at the same time, but only one can
be active at any given instant.
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Figure 47—Opening the control menu on a minimized program icon.

When two or more MS Windows applications are running concurrently, it is
possible to switch among them fairly easily. The easiest way to switch from one
application to another depends on whether the application to which you want to
switch has been minimized. If a running application has been minimized, its
program icon is displayed near the bottom of the MS Windows desktop screen
(fig. 46).

To switch from any of the SBexpert programs, for example, to any other MS
Windows application (including another SBexpert program) that is already run-
ning and that has not been minimized, simply select the program window of the
desired application to make the program window active. There are three keyboard
methods that also can be used. The basic method is as follows:

1. Open the control menu (ALT+SPACEBAR) of the currently active program
window.

2. Select Switch to (Key: W).

3. Select the application you want from the list that appears in the Task List
dialog window (Key: arrows).

4. Select the Switch To button (Key: Tab, Enter).
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There are two shortcut methods that are also the best methods for keyboard
users:

• Press Ctrl+ESC to open the Task List dialog window, then proceed with
steps 3 and 4, above.

• Or press ALT+Tab repeatedly to cycle among running applications.

To switch to another MS Windows application that is already running, but that is
displayed in a minimized state (fig. 47):

1. Select the program icon of the application to open its control menu.

2. Select the Restore option.

As a shortcut to the latter two-step method, double click on the program icon of
the application (Key: Alt+Tab).

58



Acknowledgments

We thank Terry Shore, Natural Resources Canada, Pacific Forest Research
Centre, Victoria, British Columbia; Darrell Ross, Department of Forest Science,
Oregon State University, Corvallis, Oregon; Dale Bartos, USDA Forest Service,
Intermountain Research Station, Logan, Utah; and Borys Tkacz, USDA Forest
Service, Forest Pest Management Southwestern Region, Flagstaff, Arizona, for
their careful review of the manuscript and thorough testing of the SBexpert
software.

Literature Citations

Clark, L.A.; Pregibon, D. 1991. Tree-based models. In: Chambers, J.M.; Hastie,
T., eds. Statistical models in S. Pacific Grove, CA: Wadsworth and
Brooks/Cole. 608 p.

Paine, T.D.; Stephen, F.M.; Mason, G.N. 1985. A risk population integrating
hazard and southern pine beetle population level. In: Safranyik, L, ed. The role
of the host in the population dynamics of forest insects. Banff, AB: Canadian
Forestry Service; U.S. Department of Agriculture, Forest Service: 201-212.

Reynolds, K.M.; Holsten, E.H. 1994a. Classification of spruce beetle hazard in
Lutz spruce (Picea x lutzii Little) stands on the Kenai Peninsula, Alaska.
Canadian Journal of Forest Research 24. 1015-1021.

Reynolds, K.M.; Holsten, E.H. 1994b. Relative importance of risk factors for
spruce beetle outbreaks. Canadian Journal of Forest Research. 24: 2089-2095.

Reynolds, K.M.; Holsten, E.H. 1996. Classification of spruce beetle hazard in
Lutz and Sitka spruce stands on the Kenai Peninsula, Alaska. Forest Ecology
and Management. 84: 252-262.

Saaty, T.L. 1980. The analytic hierarchy process: planning, priority setting,
resource allocation. New York: McGraw-Hill. 287 p.

59



Appendix A:
Hardware and Software Requirements

Microprocessor: An 80386 microprocessor is required for SBexpert version 2.0.

Operating system: SBexpert runs on IBM® personal computers and compatibles
with either PC-DOS or MS-DOS operating systems, running Microsoft Windows
3.1 or Windows 95.

RAM: A minimum of 2 MB of RAM is needed due to the overhead requirements
of Microsoft Windows, but 4 MB of RAM is preferable to avoid heavy Windows
system use of swap files, which can significantly impair system performance.

Video: A super-VGA monitor is required for correct display of graphic images.
Although it is possible to run SBexpert in standard VGA mode, graphic images
displayed by the application will be seriously degraded.

Disk space: SBexpert requires 7.1 MB of memory, 3.7 MB of which is needed for
storage of graphic images of stands. A larger, more complete set of stand images
that requires 14.4 MB of disk space also is available from the senior author.

Mouse: A mouse pointer device is not required to use SBexpert, but application
control is greatly facilitated by use of a mouse.
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Appendix B:
Keyboard Commands

INSIDE SBexpert:
Open control menu—

child windows
other windows

Cancel control menu
Close window—

child windows
other windows

Scroll in text window
Move to object (a set of radio buttons

move forward
move backward

Activate a selected button
Move within object
Check box choices—

select item
deselect item

List box choices—
select item
deselect item

accept selection(s)
Menu bar—

move to menu bar
move across menu bar

leave menu bar
Menus—

direct access
select menu item

Move Between Windows Applications:
Cycle among open programs
Open Task List

Control Inside Program Manager:
Cycle between groups
Open group control menu
Move among icons in group
Run application

ALT+hyphen
ALT+spacebar
ALT

Ctrl+F4
ALT+F4
arrows, PgUp, PgDn

is a single object):
Tab
SHFT+Tab
Enter
arrows

spacebar
spacebar

spacebar
spacebar
Enter

ALT

arrows
ESC

ALT + underlined letter in menu name
underlined letter in menu item name

ALT+Tab
Ctrl+ESC

Ctrl+F6
ALT+hyphen
arrows
Enter

61



Appendix C:
Basic Editing

Cursor Movement:
Home
Ctrl+Home

End
Ctrl+End

PgUp
PgDn

up arrow
down arrow
left arrow
Ctrl+left
right arrow
Ctrl+right

Del
Ctrl+Del
BkSp

Selecting Text:
Shift+Home
Shift+Ctrl+Home
Shift+End
Shift+Ctrl+End

Shift+PgUp
Shift+PgDn

Shift+up arrow
Shift+down arrow
Shift+left arrow
Shift+Ctrl+left
Shift+right arrow
Shift+Ctrl+right

move to first character in a line
move to start of text

move to last character in a line
move to end of text

move up one window
move down one window

move up one line
move down one line
move one character left
move one word left
move one character right
move one word right

delete character to right
delete to end of line
delete character to left

select to first character in line
select to start of text
select to last character in line
select to end of text

select up one window
select down one window

select up one line
select down one line
select one character left
select one word left
select one character right
select one word right
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Reynolds, Keith M.; Holsten, Edward H. 1997. SBexpert users guide (version 2.0):
a knowledge-based decision-support system for spruce beetle management. Gen.
Tech. Rep. PNW-GTR-401. Portland, OR: U.S. Department of Agriculture, Forest
Service, Pacific Northwest Research Station. 62 p.

SBexpert version 2.0 is a knowledge-based decision-support system for spruce beetle
(Dendroctonus rufipennis (Kby.)) management developed for use in Microsoft (MS)
Windows with the KnowledgePro Windows development language. Version 2.0 is a
significant enhancement of version 1.0. The SBexpert users guide provides detailed
instructions on the use of all SBexpert features. The SBexpert application now consists
of four separate programs: SBexpert (formerly, the Analysis topic in version 1.0),
SBtext, SBlit, and SBhelp. SBexpert is an advisory system for spruce beetle man-
agement that provides recommendations for reducing spruce beetle hazard and risk to
spruce stands and is the main application of the full system. SBtext and SBlit provide
complementary decision support. SBtext provides background information on the
biology, ecology, and management of spruce beetles. SBlit provides database utilities
for retrieving literature citations. Basic features of the SBexpert system include an
intuitive graphical user interface, efficient presentation and retrieval of information
through hypertext and hypergraphics, easy access to an extensive help system for MS
Windows system-level help, window-specific help, a text editor that facilitates pre-
paring standard reports from SBtext, and automatic report generation in SBexpert.

Keywords: Spruce beetle, risk, hazard, decision support, knowledge base, expert
system, management, software.
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